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Chapter 1

Welcome to GNOME

Welcome to GNOME, the General NOAA Oil Modeling Environment! This chapter
contains an overview of GNOME, a description of how to download and install GNOME
from our Web site, and an explanation of how GNOME’s online Help and this manual
can guide you as you use GNOME.

About GNOME

GNOME is a publicly available oil spill trajectory model that simulates oil movement
due to winds, currents, tides, and spreading. GNOME was developed by the Hazardous
Materials Response Division (HAZMAT) of the National Oceanic and Atmospheric
Administration Office of Response and Restoration (NOAA OR&R). HAZMAT will use
this model during spill response to calculate a “best guess” of a spill’s trajectory and the
associated uncertainty in that trajectory. You can use GNOME to …

∑ Predict how winds, currents, and other processes might move and spread oil
spilled on the water.

∑ Learn how predicted oil trajectories are affected by inexactness ("uncertainty") in
current and wind observations and forecasts.

∑ See how spilled oil is predicted to change chemically and physically ("weather")
during the time that it remains on the water surface.

To use GNOME, you describe a spill scenario by entering information into the program;
GNOME then creates and displays an oil spill "movie" showing the predicted trajectory

of the oil spilled in your scenario. Along with GNOME, most users also will want to use
the GNOME Location Files for their regions of interest; these files contain prepackaged
tide and current data, and make it easier to work with GNOME. Each Location File
prompts you for environmental conditions needed to define the circulation, then sets up
GNOME accordingly. The Location Files also contain references (both print publications
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and Internet sites) to help you find detailed information for the location you are
simulating.

The Location Files are not complete enough for use in spill response. (In the event of an
actual oil or chemical spill in U.S. waters, call the U.S. Coast Guard National Response

Center at 1-800-424-8802.) The Location Files are, however, an excellent tool for
creating scenarios and building intuition regarding oil spill trajectories at a particular
location.

What GNOME Can Do

GNOME is a trajectory model that can …

∑ Estimate the trajectory of spills by processing information that you provide about
wind and weather conditions, circulation patterns, river flow, and the oil spill(s) you
wish to simulate.

∑ Predict the trajectories that can result from the inexactness (uncertainty) in current
and wind observations and forecasts.

∑ Use weathering algorithms to make simple predictions about the changes the oil will
undergo while it is exposed to the environment.

∑ Quickly be updated, re-run, and saved with new information.
∑ Provide trajectory output (including uncertainty estimates) in a geo-referenced format

that can be used as input to GIS (geographic information system) programs.

Because GNOME was created as a tool for several kinds of users, we created it with three
model modes:

∑ Standard Mode
∑ GIS Output Mode
∑ Diagnostic Mode

In Standard Mode, GNOME’s most automated mode, a Location File loads pre-
developed location data, such as an area map and dominant current patterns, into
GNOME. GNOME’s rule-based expert system (wizard) then prompts you for

information it needs to run your model. In Standard Mode, you can save your model
setup for later use, or you can print a picture or create a “movie” of your model run.
GNOME’s Standard Mode isn’t flexible enough to use for spill response, but it is an
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excellent tool for simulating spills in spill planning and drills, and for building intuition
regarding oil spill trajectories at specific locations.

In GIS Output Mode, you also use a Location File to set up your model. In this mode,
however, you can export your model output in GIS-compatible format. GNOME can

output your trajectory in an ASCII, public domain, multi-file format (NOAA Standard
Splot Files) that can be read into a number of different GIS programs. (An extension for
ArcView GIS users is available in the Toolkit section of our Web site,
http://response.restoration.noaa.gov/software/gnome/tools.html.) The point data from
GNOME can also be read into a companion program, GNOME Analyst (formerly known
as TAT), where it can be converted into a standard NOAA vector format, printed as a
trajectory forecast, or saved in digital format for input into GIS programs for additional
analysis. GIS Output Mode is primarily used for spatial or GIS analysis for emergency
spill response.

In the tactical response mode of GNOME, Diagnostic Mode, you can use a Location File

to help set up the model, or you can set up the model entirely on your own. (Without a
Location File, GNOME requires input of shoreline and hydrodynamic information.) In
Diagnostic Mode you have these additional capabilities:

∑ You have full access to all model parameters and scaling options.
∑ You can tailor the model to represent real-time data.
∑ With advanced training and hydrodynamic modeling experience, you can develop

your own Location Files.
∑ You can set coefficients that control the size and distribution of the uncertainty used

in the “Minimum Regret” estimates. (In Standard and GIS Output Modes, the values
are set in the Location Files by the Location File builders and are not accessible to

you.)

Diagnostic Mode is designed primarily for expert modelers, such as contingency planners
and the modelers who provide full tactical support for spill response teams. This manual
does not cover the features of GNOME’s Diagnostic Mode. For training in the use of
this mode, contact NOAA HAZMAT at ORR.GNOME@noaa.gov or at (206) 526-
6317.

http://response.restoration.noaa.gov/software/gnome/tools.html
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What GNOME Can’t Do

Do not use a Location File if you are responding to a real spill. Instead, report
any oil or chemical spills in U.S. waters to the U.S. Coast Guard National
Response Center at 1-800-424-8802.

Each GNOME Location File contains generalized information about the tides, currents,
and shorelines in the region it covers. GNOME uses this information to make trajectory
predictions for spills in that region. Because Location Files contain only climatological

information, rather than information about the specific conditions at a particular date and
time, they aren’t designed to accurately model real spills. During real spills, NOAA’s
response team uses GNOME in its advanced Diagnostic Mode, and all of the data entered
into the model is carefully examined to determine if it applies to the scenario at hand. The
team can also enter more exact, “real-time” current and tide information, and can track
the movement of the oil to fine-tune their trajectory predictions.

Similarly, a Location File won’t accurately recreate a real spill, such as the Exxon Valdez
spill in Prince William Sound. The currents in GNOME’s Location Files are created from
climatological data; however, real currents vary from the mean and are not steady in time.
Using a Location File in Standard or GIS Output Mode, you can’t change currents part

way through a spill simulation. Consequently, recreating such a complex spill is limited
by the Location File’s climatological environmental information.

If you’d like assistance with trajectory analysis and spill-related issues, contact your local
NOAA Scientific Support Coordinator (SSC). You can find out how to contact your local
SSC from the NOAA HAZMAT main office at (206) 526-6317.

Getting and Installing GNOME

GNOME is publicly available via the Internet in both Macintosh and Microsoft Windows
formats. GNOME and its Location Files may be freely used and distributed.

GNOME is a 32-bit application, so it runs in Windows 95/98/NT, but not in Windows
3.1. The Windows version requires 1.6 MB of RAM. The screen resolution in Windows
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must be set to a minimum of 640 x 480 pixels in order for the dialog boxes to display
properly. The Macintosh version of GNOME requires a Power PC running System 7 or
higher, and requires 740K of RAM.

To download and install GNOME, use your browser to go to the Downloading,
Installing, and Running GNOME section of the NOAA HAZMAT Web site, located at
http://response.restoration.noaa.gov/software/gnome/gnomeinfo.html. This web page
outlines the steps you should follow to download, install, and run GNOME for Macintosh
or Windows computers.

If your browser does not support FTP downloading, you can use an FTP client
application. You can get more information from this section of our Web site:
http://response.restoration.noaa.gov/software/gnome/gnomeftp.html.

If you want to view your saved GNOME files in the mapping software, ArcView, you
will need the GNOME ArcView extension, gnome.avx. Instructions for downloading and

using this extension file are provided in the Toolkit section of our Web site,
http://response.restoration.noaa.gov/software/gnome/tools.html.

How to Get What You Want From GNOME

As you begin working with GNOME, you should experiment with the model to improve
your skill and intuition in trajectory analysis. To learn how oceanographic and

atmospheric conditions influence oil spill trajectories, we recommend that you try
running the model with different tides, different wind speeds and directions, and with
different current patterns or different river flow rates (if applicable). To run the model
with different tides, adjust the start and stop times to set the scenario during different
phases of the tide cycle. Strong winds can control the oil spill trajectory, so try a variety
of speeds and directions. (GNOME does provide some error checking for realistic values,
but you should try to check that your values are realistic for the location you are
modeling.) Because each Location File includes only the commonest conditions found in
an area, you won’t be able to simulate all aspects of a region's circulation and wind
patterns, or transitions from one pattern to another.

To create a specific scenario for a training exercise or demonstration, choose the current
pattern (if applicable) or river flow (if applicable) that best directs the oil spill in the
direction you would like it to go. Adjust your trajectory by changing the speed and

http://response.restoration.noaa.gov/software/gnome/gnomeinfo.html
http://response.restoration.noaa.gov/software/gnome/gnomeftp.html
http://response.restoration.noaa.gov/software/gnome/tools.html
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direction of the winds as the spill develops. As you are developing your model, be sure
that your winds are realistic for the location you’ve selected.

We also recommend that you include the “minimum regret” (uncertainty) solution in
your model runs. GNOME can compensate for typical errors in the wind and current

input data. (For example, the weather forecast may be inaccurate in the timing of a frontal
passage, in the speed or direction of the winds, or in the strength of the currents.) By
taking these uncertainties into account, GNOME can predict many possible trajectories
for your spill. This information allows responders to create more comprehensive response
plans in which the value of a resource can be balanced against the probability that it may
be impacted by a spill. The tutorial in the next chapter describes the “minimum regret”
solution in more detail. The additional calculations required to run the “minimum regret”
solution slows the model somewhat, so you may want to run this solution after you have
fine-tuned the “best guess” trajectory.

To further build your skills at using GNOME, try some of the example problem sets
available at http://response.restoration.noaa.gov/software/gnome/examples.html.

If you want to run a spill trajectory in which you specify conditions other than those
included in GNOME (for example, you need to modify the current patterns developed by
NOAA or import current patterns from other sources), you’ll need to learn to operate
GNOME in Diagnostic Mode. For training in the use of Diagnostic Mode, contact NOAA
HAZMAT at ORR.GNOME@noaa.gov or at (206) 526-6317.

Getting Help

You can get online help at any time when you are running GNOME.

The Help Menu

Use GNOME’s Help menu to view explanations of GNOME’s main functions and
features. The Help menu differs between the Macintosh and Windows operating systems.

On a Macintosh

If you’re using GNOME on a Macintosh, select Topics… from the Help menu to display

an alphabetical listing of GNOME Help Topics.

http://response.restoration.noaa.gov/software/gnome/examples.html
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Select the Topics… menu item (background) to view the
GNOME Help Topics (foreground) on a Macintosh.

Highlight a topic name, then click Select to view a discussion of that topic:

Sample GNOME Help topic on a Macintosh
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In Windows

If you’re using Windows, select Contents from the Help menu.

Select the Contents menu item (background) to view the
GNOME Help contents (foreground) in Windows.

The Contents menu item displays the Help topics that are available to help you as you use
GNOME. Click any of the underlined topics to view the discussion of that topic:
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Sample GNOME Help topic in Windows

For more information about the Help menu choices, see the Reference chapter of this
manual.

Help Buttons

You can also click Help buttons on GNOME windows and dialog boxes to view
information about particular features or required model inputs.

Click Help in GNOME dialog boxes to get more information.
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GNOME also provides references for data relating to wind, river flow, and current
patterns to help you enter appropriate information into the model. As you work in
GNOME, you will see buttons, such as Finding Wind Data, Finding Flow Data, and
How to Select a Current Pattern. Click the appropriate button to get help with the
weather and oceanographic conditions for your region of interest.

Click Finding Wind Data (background) to learn more about wind

conditions for your region of interest (foreground).

In some GNOME windows, you can get more information by clicking a More… button.

Click More… (background) to learn more about a topic (foreground).
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How to Use This Manual

This manual includes five chapters to help you learn to use GNOME. After reviewing
this chapter, turn to Chapter 2 for a step-by-step GNOME tutorial. Chapter 3 contains
information you will need if you plan to work in GNOME’s GIS Output Mode. Refer to
Chapter 4 for descriptions of the main features of GNOME. Sections of this chapter
include explanations of GNOME’s Location Files, the Map Window, and GNOME’s
toolbar and menus. In Chapter 5 you can find some trouble-shooting advice and, at the
end of the manual, you’ll find a glossary of terms and an index.
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Chapter 2

Learning the Basics

This chapter guides you, step-by-step, through a GNOME scenario describing a
hypothetical crude oil spill into Long Island Sound. Follow along, using your own copy
of GNOME, to familiarize yourself with GNOME’s features and capabilities. For more
information about any aspect of GNOME, refer to the Reference chapter (Chapter 4) of
this manual.

Introduction

It’s just after 3:30 a.m., Pacific Standard Time. Your day began when your pager went
off a few minutes ago. Now you’re arriving in the main “warroom” of NOAA
HAZMAT’s oil spill response team in Seattle, where other team members are
assembling. The amplified voice of NOAA’s New York-based Scientific Support
Coordinator (SSC) is coming in over the speaker phone. He’s reporting a “no-notice”
drill, based on a tanker that has collided with a cargo barge, spilling crude oil into Long

Island Sound. Local Coast Guard officers are collecting more details about the spill from
on-scene observers and the tanker’s manifest. NOAA’s job during the next hours or days
is to provide scientific information and support to the Coast Guard and other members of
the Unified Command (representatives of the “spiller” and the local, State and Federal
agencies in charge of the spill response).

Your NOAA colleagues have begun to compile the basic information that’s needed for an
actual oil spill response:

∑ Marking the spill location (reported to be roughly 10 miles, or 6 km, southeast of
New Haven) on a navigation chart of the area,

∑ Collecting weather reports and forecasts from the NOAA National Weather
Service, and
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∑ Checking for “sensitive sites”—locations or resources especially vulnerable to harm
from oiling—in the general area that could be affected by the spill (for example,
shellfish beds, seabird rookeries, marine mammal haul-out grounds, marinas,
historical sites, and public beaches).

Your job as a trajectory modeler is to provide trajectory estimates of the spilled oil, to
identify which areas of Long Island Sound could be affected by the moving, spreading oil
slick, and to determine whether the oil might beach along any sections of the coast.

To perform this task, you’ll use the GNOME model by:

∑ First entering information that describes the drill scenario. A scenario is a
representation of the oil spill (where, when, how, how much, and what type of oil has
spilled) within the current environmental setting (prevailing winds and currents, type
of shoreline, etc.).

∑ Then viewing an “oil spill movie,” or animation of the trajectory of the oil spilled in
your scenario.

You’ll use GNOME to create an animated depiction of the predicted trajectory of the oil
spilled from the leaking tanker into Long Island Sound and then update that trajectory
based on observations of the spill from actual overflights.

NOTE: In this exercise, you’ll actually be using the GNOME Location File for
Central Long Island Sound, which contains “canned,” or generalized, information
about the currents and tides in that region. During a response to an actual oil spill,

NOAA’s response team uses more advanced features of GNOME along with more
exact, “real-time” weather, current, and tide information. The team members also
track the movement of the oil in order to fine-tune their trajectory predictions. Using
a Location File for a real spill response can be dangerous!

Gearing Up

You’ll need both GNOME and the “Central Long Island Sound” Location File. You can
download both from the Internet, as follows:
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1  To download GNOME, open the following web page in your browser, then follow the
instructions you’ll see on that page to download and install GNOME on your computer.

http://response.restoration.noaa.gov/software/gnome/gnomeinfo.html

2  The Central Long Island Sound Location File accompanies GNOME. Later, if
you want to download a different Location File, open the following web page, then
follow the instructions you’ll see on that page to download the file to your computer:

http://response.restoration.noaa.gov/software/gnome/locfiles.html

Setting Up Your Scenario

1  Start GNOME.

In Windows 95, 98, or NT:  From the Start menu, select the GNOME submenu,
then choose GNOME.

On a Macintosh computer:  Open the GNOME folder, then double-click the

GNOME program icon,  .

You’ll then see the Welcome to GNOME dialog box via its Wizard interface:

Click Next.

http://response.restoration.noaa.gov/software/gnome/gnomeinfo.html
http://response.restoration.noaa.gov/software/gnome/locfiles.html
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2  You’ll see the Selecting a Location File dialog box below:

You’re about to open the GNOME Location File for Central Long Island
Sound. Each GNOME Location File contains generalized information about the
tides, currents, and shorelines in its specific region. GNOME uses this

information to make trajectory predictions for spills in that region. Although using
a Location File is the easiest way to use GNOME, Location Files contain only

generalized information (rather than information about specific conditions at a
specific date and time) and thus are not designed for accurately modeling real
spills. To model a real spill, you will need to receive either training or expert help
to use GNOME in its advanced Diagnostic mode.

Click Select file.

3  You’ll see the Open a File dialog box below. Find and click the file named Central
Long Island Sound.

Then click Open.
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4  Read the information on the next dialog box, Welcome to Long Island Sound,
New York.

This dialog box simply tells you what steps are coming up. Click Long Island
Sound References if you’d like to see a list of print and online references
helpful for oil trajectory modeling in this region.

Then click Next.

5  You’ll see the Model Settings dialog box below. Enter the Model Start Date and
the Model Start Time when you’d like the spill movie to begin and the Model Run
Duration for the movie.

Both the Model Start Date and Start Time must be set at or before the
beginning date and time of the oil spill. We said earlier that it’s December 1,
1999, and the tanker crew has reported that the spill began at about 5:30 a.m.,
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Eastern Standard Time. Set the model (movie) to start at that date and time (using
the 24-hour time system and omitting the time zone).

We’ll talk about Best Guess and Minimum Regret solutions later, in the
section “Dealing with Uncertainty.” For now, leave the Include Minimum
Regret (Uncertainty) solution box unchecked.

When you’ve finished entering the start date and time and the model (movie) run
duration, your screen should look like the one above.

Now click Next.

6  You’ll now see the Choosing Wind Type dialog box. Here, you’ll need to indicate
whether the wind is:

∑ blowing steadily at a particular speed from a particular direction (constant wind)

or

∑ changing speed and direction frequently (variable wind)

The National Weather Service has reported that winds in the vicinity of the spill
have been blowing quite steadily at 15 knots from the south, and are forecast to
continue for the rest of the day. Thus, because the winds are expected to remain
steady, constant wind is the best choice here.

Select constant wind, then click Next.
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7  You are now looking at the Constant Wind dialog box.

Enter 15 in the wind Speed box, check that knots is the selected
unit of speed, and that S (south) is the direction the wind is blowing

from.

You can also use the blue Wind Target (right side of the dialog box) to enter
wind speed and direction. To learn how to use this, click Help—or just
experiment.

Then click Next.

8  You will now see the Almost Done dialog box.

You’re about to view the Map Window. This dialog box tells you what tools and
controls you’ll be using there.
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Click To the Map Window.

9  You will now see the Map Window: General NOAA Oil Modeling
Environment.

Check that the Spill tool  is selected in the toolbar.

Now click anywhere within the water area of the map to set the location of the
spill. You will discover that if you try clicking on the tan-colored land areas (or
on certain water areas where GNOME’s data are not adequate), you will be
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alerted, by the symbol , that GNOME cannot predict the trajectory of oil spilled
from that area.

By clicking on the map, you are setting an approximate location of the spill,
indicated by a small +. In a moment, the next dialog box pops up, where you can

adjust that setting to match the exact latitude and longitude of the spill (41 deg.,
13.71 min. North; 72 deg., 44.78 min. West), as reported by the New York SSC.

10  You are now at the Spill Information dialog box.

Enter the remaining details about this scenario:

(1)  From the Pollutant menu, select medium crude.

You can use GNOME to predict the trajectories of a range of oils by simply choosing
the pollutant category closest to the one that has spilled. In this case, it’s “medium
crude,” since the drill scenario specifies that the tanker spilled a medium crude oil.
GNOME automatically factors in the weathering characteristics of any type of spilled
oil during its exposure to the elements UNLESS you select non-weathering in the

pollutant menu. The weathering behaviors of different oils are critical to predicting
their trajectories. With time, part of the oil evaporates and part of it disperses into the
water, so that less and less of the oil remains on the surface, and this remaining
surface oil also changes physically over time.
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(2)  For Amount released, enter 1,000, and check that barrels is the selected
unit of volume.

(3)  Make sure that the Release Start date and time are December 1,
1999 and 5:30 a.m. This is the date and time that the spill begins and NOT
the Model Start date and time, which you already entered in the Model
Settings dialog box, Step 5.

(4)  Adjust the latitude (Lat) of the spill to 41 deg., 13.71 min. North,
and the longitude (Long) to 72 deg., 44.78 min. West.

This is the location of the spill, as reported to you by the New York SSC. If the spill
had continued for a period of time, or had continued as the tanker moved across the
water, you also would need to enter a Different End Release Time or Position.
But in this Long Island Sound incident, the Coast Guard officers have reported that
the tanker spilled oil over a period of just several minutes, through a hole in a single

tank: this spill was brief, and happened in just one place.

Once your screen looks like the one above, click OK.

11  The map of central Long Island Sound will now be redrawn before your eyes, with
the location of the spill indicated by a small +.
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Running the Spill Movie

You’re now ready to run the trajectory animation, or spill movie.

1  To run the movie, press the Run control ( ).

You should see an animation of the predicted oil spill trajectory. When it has
finished, your map should look like this:

In GNOME, a volume of spilled oil is represented in your Map Window as a set
of small dots that we call splots (mathematicians would call them Lagrangian
elements, or LEs.). Each splot represents part of the spilled oil. During the spill
movie, you watched as the splots moved across your screen like a swarm of bees.
They represent GNOME’s prediction of how the oil that spilled from the tanker

would be moved across the water surface by winds, currents, and turbulent
processes.

The movie showed how the spilled oil is predicted to move during the first 24
hours after the start of the spill (since, back in Step 5, you set the Model Run
Duration to 1 day). Now that the movie has stopped, you can see that all the
splots are arranged along the coastline, indicating GNOME’s prediction that, by
the end of day 1, nearly all the oil will have beached (washed ashore) along the
Connecticut coast just north of the spill location.



Chapter 2:  Learning the Basics

24

Now that you’ve viewed the spill movie once, there are some other things to try:

∑ To rewind the movie and view it again, press the Reset control ( ), then

press Run ( ) again. As you watch the movie, you can pause at any point

by pressing the Pause control ( , which appears only while the movie is
running). You also can drag the Time Marker (the small triangle just below

the Movie Progress Bar, ) left or right to view particular moments

during the spill.

∑ To zoom-in for a closer look of the spill area, click on the Zoom-In tool ( )

in the toolbar. Then outline the area you want to zoom-into by holding down
your mouse button, dragging diagonally across the part of the map that you
wish to see up-close, then releasing your mouse button. To zoom back out,

click the Zoom-Out tool ( ), then click on the map (which will be redrawn

centered on the point where you clicked).

∑ To adjust the position of the map in the Map Window, click the Hand tool

( ), then drag the map into a new position.

Dealing With Uncertainty

Now that you’ve completed your initial trajectory prediction, you and your colleagues
will gather to review your findings. In a few minutes, you’ll need to pass along what
you’ve learned to the New York SSC, who is now on-scene on the Connecticut coast,
working with the spill responders there.

You’ve learned where GNOME has predicted the spilled oil will go. Meanwhile, the
team’s marine biologist has prepared a map (below) showing the environmentally
sensitive areas in the vicinity of the spill:
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She refers to this map of sensitive areas as she looks over your GNOME output. She
notes that:

∑ If the spilled oil goes where GNOME has predicted, state shellfish beds to the east
and west of the oiled coastline will not be oiled in the first 24 hours.

∑ Likewise, marshlands along the West and East Rivers are predicted to be
unaffected.

∑ Areas predicted to be threatened by this spill include (1) offshore islets and rocks
used as nesting sites by seabirds and (2) the rugged, sheltered coastline west of
Sachem Head.

Another of your NOAA colleagues scrutinizes your trajectory map and the biologist’s
findings, and asks, “How accurate is your trajectory prediction? How sure are you that

the shellfish beds and riverside marshes will not be oiled?”

To answer this question, you need to consider the effects of uncertainty in the
information you entered into GNOME. When you ran your spill movie, what you saw
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was GNOME’s best guess of the trajectory of the oil. But in trajectory modeling, even
the best-available information on forecast winds and currents can often contain errors,
because winds and currents aren’t entirely predictable. It’s rare for wind speed and
direction forecasts to be precisely accurate, and it’s even less possible to precisely predict
current patterns.

This inherent uncertainty explains why the NOAA oil spill response team does not rely
solely on trajectory modeling, but also observes and tracks spilled oil to check the
accuracy of their models and make adjustments as needed.

In the particular case of this Long Island Sound drill,

∑ the wind may change speed and/or direction somewhat from the National Weather
Service forecast, and

∑ current patterns in the Sound at the time of the spill are unlikely to match the

generalized information in the Location File.

We know that our wind and current information is, to a degree, uncertain. What this
means is that we must not only obtain the best guess trajectory, but must also be able
to predict what the errors caused by this uncertainty will mean.

The following section will explain how to accomplish this using GNOME.

Best Guess & Minimum Regret Trajectories

1  In the menu to the left of the map, under the Model Settings heading, click on the
box labeled Include the Minimum Regret solution.
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2  Press the Run control ( ) to rerun the spill movie.

This time, you’ll see both black and red splots on the map. By the time the spill
movie stops, you’ll notice that the two kinds of splots are arranged like this:

The black splots have accumulated along the coast between the shellfish beds, just as
they had before. The red splots, however, have accumulated along a much longer stretch
of the coastline, and some still remain out in the water. Unlike the black splots, some of

the red splots have reached the shellfish beds, and some have accumulated at the mouths
of the West and East Rivers, where oil could potentially penetrate into the riverside
marshlands during high tides or storm surges. Red splots appear within a larger area,
encompassing the rocks and islets important to nesting seabirds and along additional
sections of rugged, sheltered shorelines that may be difficult to clean if oiled.

To understand what GNOME is showing you here, there are two things to consider.

∑ the black splots represent GNOME’s best guess trajectory estimate of the oil
spilled from the tanker. To make this best guess, GNOME assumes that (1) the
winds continue to blow steadily at the speed and from the direction you entered into

GNOME, and that (2) the data in the Location File accurately represent the current
patterns during the time of the spill. When making a best guess, GNOME accounts
for the turbulence that is inherent in natural processes, such as winds and currents,
but NOT for errors in wind forecasts or current patterns.
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∑ the red splots represent GNOME’s larger minimum regret trajectory estimate for
the same spill. To predict this trajectory, GNOME accounts for uncertainty in the
wind and current information that you entered. As a very rough rule of
thumb—assuming a “typical” degree of uncertainty in the wind and current

information you use in modeling a spill scenario—the chance that the spilled oil
will remain within the area covered by the red splots is on the order of 90%. It is
impossible to assign a more precise probability, because little is yet known about
uncertainties in wind and current forecasts, although NOAA is actively researching
this topic.

Predicting a minimum regret trajectory allows you to consider spill outcomes that are
less probable than the best guess  outcome, but that are potentially either more

harmful or more costly.

3  Your next task is to brief the New York SSC on your trajectory estimates using
GNOME, so that he can inform the Unified Command where the spilled oil will most
likely go. The Unified Command will use your trajectory prediction, along with
information from other experts and their own observations and expertise, in deciding
where to implement protective countermeasures, such as placing booms and skimmers.

What should you tell the New York SSC?

You should show him both the best guess and minimum regret trajectories,
explaining that:

∑ The oil will most likely follow the smaller best guess trajectory (within the
black splots).

∑ There is a roughly 90% probability that the spilled oil will NOT extend beyond
the minimum regret trajectory (the larger area covered by the red splots).

The response team needs to consider protection measures for biologically sensitive
locations anywhere in the area encompassed by the minimum regret trajectory—and
NOT just within the smaller best guess area covered by the black splots.
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This is where the concept of “minimum regret” enters the scenario:

A response team will be least likely to regret their response choices if they develop a
protection strategy for the area encompassed in the minimum regret trajectory, rather

than just the smaller best guess area.

In the case of this drill scenario,

∑ The Unified Command might select protection strategies (such as placing boom
across the river mouths) to minimize the amount of oil penetrating into the
marshes.

∑ They also might develop strategies (such as placing boom or using skimmers) to
help prevent oil from reaching the shellfish beds.

Reinitializing your GNOME Trajectory
relative to Overflight Observations

Later in the day, the response team is able to conduct an overflight of the spill area to
visually locate slicks and sheens of oil on the water. The NOAA SSC made aerial
observations from a helicopter to spot oil on the water in the vicinity of Sachem Head.

Two large areas of black oil and two smaller areas of brown oil were spotted, with silver-
to-rainbow sheens trailing them to the west and south, something like this:
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Overflight information is very important for trajectory modelers because it helps you
calibrate your trajectory. Using the SSC’s observations, you can create a hindcast
trajectory to see how well your modeled spill trajectory matches the actual overflight
observations of the spill. The response team plans to conduct additional overflights at
1700 today (December 1, 1999) and another tomorrow morning at 0800 (December 2,

1999).
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In the meantime, the Coast Guard officers now need updated trajectory materials as they
continue to plan for the spill. First, you need to create a hindcast trajectory to update
your scenario to more closely match the overflight results.

1  Before you start, you’ll want to uncheck the Include Minimum Regret solution
box in the Summary List to the left of the map.

2  You will need updated wind observations, which you can find at weather-related
Internet sites. (Check the GNOME Help topic Wind Data, Finding for wind and
weather sources.)

These are the observed winds until noon December 1, 1999.

12/01/99 0500 15 knots S
12/01/99 0600 10 knots S
12/01/99 0700 18 knots S
12/01/99 0800 10 knots S
12/01/99 0900 18 knots S
12/01/99 1000 05 knots S
12/01/99 1100 06 knots S
12/01/99 1200 09 knots S

3  Double-click the name Central Long Island Sound in the Summary List. Click

Next until you see the Choosing Wind Type dialog box. Choose variable wind, then
click Next.

4  Enter the observed winds in the Variable Winds dialog box:

(1) Be sure the date is December 1, 1999, the date of the first wind record.

(2) Enter the first wind time (0500).

(3) Enter the first wind speed and direction (15 knots from the S)
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(4) Because the winds observations are 1 hour apart, enter an auto-increment time
of 1 hour.

(5) Click Add New Record.

Your first wind record, including wind date, time, speed, and direction, will appear in
the Wind Records table in the lower left section of the window.

(6) Enter the remaining wind records by repeating steps 1 – 5 above, or by using the
blue Wind Target. Click within the target on the point that represents the wind
speed and direction you want to enter (for example, the intersection of the S axis

and the 10-knot circle). If necessary, you can hold down your mouse button and
drag to adjust the wind speed and direction to the combination you want. Then
release the mouse button.

Once your screen looks like the one above, click Next.

Next, you will run the model until noon to see how well you simulated the spill.
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5  Select the Run Until item from the Model menu, and change the Stop Time to
1200.

Your trajectory should look like this:

Not bad for a first try! (Trajectory modelers can adjust the parameters in GNOME
to make the modeled scenario and the actual spill agree more closely, although
that involves advanced training. For our learning purposes, we have an excellent
simulation.)

Now that you've tested your trajectory, you can make your next forecasts. This will
involve two steps:

(1)  Updating the wind with a new forecast, and

(2)  Reinitializing the spill relative to the overflight map.

The new forecast is for winds from the S at 10 knots through midnight, increasing to S at
20 knots by morning.

6  Add the observed winds in the Variable Winds dialog box.
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Here is an example of how to create that file:

12/01/99 1300 10 knots S
12/01/99 1800 10 knots S

12/02/99 0000 10 knots S
12/02/99 0400 15 knots S
12/02/99 0800 20 knots S

These records are not hourly (or of any consistent increment). To enter them
easily, go to the Wind Records table and select the last row, which contains
only asterisks (****). Enter the new record information in the Date, Time,
Speed, and Wind from boxes. Click Add New Record.

Once your screen looks like the one above, click Next.

7  Next, you will use the overflight tools to spray splots to match the overflight map. To
add the overflight observations to GNOME, you will use the Spray Can tool to "spray"
the spill on the map to show its current location and extent.

Before you add your overflight results to GNOME, you may want to delete your original
spill so that you can easily see the overflight results.
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(1) First, save your original spill as a Location File Save. To do this, select Save
from the GNOME File menu, then click OK. Choose a file name and folder, then
click Save.

(2) Next, to delete the original spill from your map, select the description of the
spill, Medium Crude: 1000 barrels, listed under Spills in the Summary List.
From the GNOME Item menu, select Delete, then click OK.

Now, before you spray splots on the map, you need to provide more information about
the overflight and pollutant.

8  Enter the details about the overflight.

(1) Click the Spray Can tool,  , on the GNOME toolbar.

You'll see the Overflight Information dialog box, where you'll enter information
about the overflight and the pollutant that was released.

(2) Enter the date and time of the overflight.

The overflight was conducted at noon (1200) on December 1, so you'll need to
adjust the time shown in the dialog box.

(3) Select a pollutant type from the menu.
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The response team confirms that the pollutant released in the Sound is a medium
crude. When you select medium crude from the Pollutant menu, you'll notice that
the information boxes change. (In this dialog box, the information that you must enter
varies, depending on the information that you have already entered. For instance, you

must enter different information if you select a pollutant that weathers than if you
choose a non-weathering pollutant.)

(4) Enter the amount of the release, select the appropriate units from the menu, then
select the time when the release amount was estimated.

Here, you can enter the Amount Released estimated at the Time of Spill or at the
Overflight Time. At this time, the New York SSC advises that a more accurate
estimate of the amount originally  released is 2500 barrels. Enter that amount and
select Time of Spill.

You should be aware that estimates of pollutant volume from overflights are highly
inaccurate. An observer may see black oil on the surface of the water and think that
it's very thick; however, the oil could actually be as thin as .001 inch (thinner than a

layer of paint on a wall)!

(5) Enter the date and time of the spill.

Check that the Time of Spill boxes show December 1, 1999 and 5:30 a.m. (0530)
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Once your screen looks like the one below, click OK.

9  Change the Model Start Time.

Once you've clicked OK, GNOME will prompt you to change the Model Start
Time (your "movie" start time) to coincide with the Overflight Time.

Click Change.

10  Choose the size of the spray can diameter.

You can choose a small, medium, or large diameter of spray to use when you
"draw" the overflight observations on the map. Click Medium, then click OK.
Your cursor will change to a "medium-size" circle over the water areas of the
map. Later, you can change the spray diameter by double-clicking the Spray
Can tool.

11  Spray the overflight observations on the map.

Before you "spray" the spill on the map, use the zoom-in tool ( ) and hand

tool ( ) to get a better view of the area of the spill. To "spray" the spill on the
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map, click an appropriate water region of the map, hold down your mouse button,
then drag the cursor to spray pollutant particles.

If you spray an area in error, you can remove the particles with the Eraser tool.

To do this, click the Eraser tool, , on the GNOME toolbar. (Your cursor will

change to a square.) Drag the cursor over the area of pollutant to be removed, then
release your mouse button. Any land areas or lines of latitude or longitude that
you "erase" from the map will be immediately redrawn.

Your reinitialized scenario should look something like this:

12  Click the Arrow tool, , on the GNOME toolbar to leave the editing mode.

13  Because the New York SSC and the Coast Guard will want to see both the
Minimum Regret and Best Guess trajectories, click on the box labeled Include the
Minimum Regret solution in the left section of the Map Window.

14  Try running this scenario until 1700 December 1, 1999. Use the Run Until item

from the Model menu.
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Your trajectory should look something like this:

15  Try running this scenario until 0800 December 2, 1999.

Your trajectory should look something like this:

The spill response team will now disregard the earlier trajectories created in GNOME.
But let's take a look at the trajectory we originally expected the oil to follow and compare

it with our reinitialized trajectory.
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This was our modeled trajectory for 0530 on December 2nd.

This is the same view of our reinitialized trajectory for 0800 December 2nd.

You can see that the reinitialized oil-spill trajectory covers the shoreline quite differently

than the first trajectory predicted. The reinitialized trajectory—incorporating the actual
distribution of oil, actual observed winds, and a more recent wind forecast—provides a
more reliable forecast of the spill trajectory.
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This process of looking at the overflight map, hindcasting the spill to check the model,
and creating new predictions continues twice each day throughout the spill response. In
working through the process, both the weather forecaster and the HAZMAT modeler
become more familiar with the region and gain skill in their forecasting. By reviewing the
observations of oil movement and wind conditions, they can refine their predictions and

enable the response team to more successfully respond to the spill.

Exiting (Quitting) GNOME

When you’ve completed your work with GNOME, just choose

Quit from the File menu if you’re using a Macintosh, or

Exit from the File menu if you’re using Windows.

You can also first save any GNOME trajectory as a file that you can reopen later in
GNOME, or as a “movie” that you can view in QuickTime™. To do this, click Save
under the File menu, select a file type, then click OK.

What Now?

You’ve just completed an initial guided tour of GNOME. At this point, you should be
able to create and model simple oil spill scenarios, and you should be aware of important
trajectory modeling concepts, including the effect of uncertainty on modeling outcomes.

To further build your skills at using GNOME, we invite you to try some of the GNOME
example problem sets available at

http://response.restoration.noaa.gov/software/gnome/examples.html.

You also might prefer to start using GNOME in your own work. GNOME is an
appropriate tool for a variety of purposes. Here are just a few:

∑ conducting tabletop exercises to train spill responders.

∑ improving your understanding of how oil spills might affect a coastal region for
which you have planning responsibilities, or where you are a spill responder.

∑ preparing classroom demonstrations, exercises, or science projects.

http://response.restoration.noaa.gov/software/gnome/examples.html
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You can find other materials to help you to understand and use GNOME at

http://response.restoration.noaa.gov/software/gnome/gnome.html.

Good luck with your work, and remember that you can contact us with questions and
concerns about GNOME at ORR.GNOME@noaa.gov.

http://response.restoration.noaa.gov/software/gnome/gnome.html


43

Chapter 3

Working with GIS

Geographic Information System (GIS) users can obtain GIS-compatible output in
GNOME’s GIS Output Mode. This mode lets you save geo-referenced files of oil
locations at specific times. This information can then be used by various GIS programs or
post-processed to provide contours of oil distribution. In GIS Output Mode, as in
Standard Mode, GNOME uses the generalized information contained in its Location
Files; however, this mode offers these additional output options for GIS users:

∑ GNOME can generate an ASCII, multi-file oil distribution output. The file format

adheres to NOAA’s published standard trajectory output.1  One file (or two, if you
include uncertainty splots in your trajectory) is a geo-referenced file provided in
MOSS (Map Overlay Statistical System), a public domain GIS format. The MOSS
file can be read into a number of different GIS programs for additional geo-spatial
analysis.

∑ The point data from GNOME can be read into a companion program, GNOME
Analyst (formerly known as TAT),which can derive oil concentration contours
through Thiessen analysis. These oil concentration contours can also be exported in a
GIS-compatible format.

File Formats

In GIS Output Mode, as in Standard Mode, you can save a trajectory as a picture or a
movie:

∑ Location File Save (.LFS) – An output file format that saves all the information you
have entered into GNOME using a Location File.

∑ QuickTime Movie (.mov) – A “movie” animation of a modeled spill, produced
hourly, which will run as a stand-alone file that can be viewed with QuickTime™.

                                                  
1 J.A. Galt, D.L. Payton, H. Norris, and C. Friel, Digital Distribution Standard for NOAA
Trajectory Analysis Information, HAZMAT Report 96-4, January 1996.
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To view QuickTime files, you will need the free QuickTime player available for
download at http://www.apple.com/quicktime/download/.

NOAA Standard Splot Files

You can also export your GNOME trajectories as NOAA Standard Splot Files. GNOME
offers two formats:

∑ NOAA Standard Splot Files (for GIS) – A single snapshot output that saves only a
single view of the spill at a single time and day.

∑ NOAA Standard Splot File Series (for GIS) – An output of NOAA Standard Splot
Files throughout the animation of the spill model. Saves a series of successive views
of the spill, at 1-hour intervals.

To work with NOAA Standard Splot Files, you will need a mapping program that can
directly import MOSS formatted files (such as MOSS or ARC/INFO). For ArcView
users, HAZMAT has created an extension (gnome.avx) that allows import of the splot

files, as well as contour information from GNOME Analyst. This extension is available
in the GNOME Toolkit section of our Web site. Instructions for downloading and using
the extension are provided at
http://response.restoration.noaa.gov/software/gnome/tools.html.

The number of files that GNOME creates will vary, depending on the duration of your
model and whether or not you have chosen to include the minimum regret trajectory.
GNOME outputs files 3 through 7, which contain the following information:

File 3 (.ms3) Header information, such as scenario information and any caveats.
File 4 (.ms4) Position data for the “best guess” (forecast) splots.

File 5 (.ms5) Attributes of each of the “best guess” splots.
File 6 (.ms6) Position data for the “minimum regret” (uncertainty) splots (if

included in the trajectory).
File 7 (.ms7) Attributes of each of the “minimum regret” splots (if included).

Sample files are shown in the Appendix.

http://www.apple.com/quicktime/download/
http://response.restoration.noaa.gov/software/gnome/tools.html
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GNOME Splot Files

You can also save your GNOME trajectory in a file format that can be further processed
in GNOME Analyst to create contours of oil distribution. To process GNOME Analyst
files, choose either of these formats:

∑ GNOME Splot File (for GNOME Analyst) – A single snapshot of the spill for
GNOME Analyst.

∑ GNOME Splot File Series (for GNOME Analyst) – An hourly file output
throughout the spill animation for GNOME Analyst.

GNOME Analyst converts the "best guess" splots displayed in GNOME to oil
concentration contours, and the "minimum regret" splots to a bounding contour. Here are
some example outputs.

Splots generated in GNOME.
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Oil concentration contours and uncertainty boundary generated in GNOME Analyst.

BNA Map Files

To create oil concentration contours in GNOME Analyst, you will need a map file on
which to display the contours. You can open your own vector map in GNOME Analyst,

or you can export the map from the GNOME Location File and open it in GNOME
Analyst. To save the Location File map as a file, choose the file type BNA Map File (for
GNOME Analyst).

To learn more about GNOME Analyst or to obtain training, contact NOAA HAZMAT at
ORR.GNOME@noaa.gov or at (206) 526-6317.  

Wind Data Files

Spill responders use NOAA HAZMAT's oil weathering program, ADIOS“, which

allows time-dependent winds. If you create a time-dependent wind in GNOME, you can
save that wind as a text file in GIS Output Mode, then read it into ADIOS without having
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to re-enter the winds. To save your winds as a file for ADIOS, choose the file type Wind
Data File.

Help with GIS Terminology

An online dictionary of GIS terms is available to GIS users by the Association for
Geographic Information and the University of Edinburgh Department of Geography at

this Web site: http://www.geo.ed.ac.uk/agidict/welcome.html. The dictionary includes
definitions for 980 terms compiled from a variety of sources, which either relate directly
to GIS or which GIS users may come across in the course of their work. The dictionary is
supplemented by 52 diagrams.

http://www.geo.ed.ac.uk/agidict/welcome.html
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Chapter 4

Reference

Here are explanations of the main components of GNOME: Location Files, the Map
Window, and the GNOME toolbar and menus.

Location Files

GNOME’s Location Files were created to guide you through the model setup for a
specific region. A Location File is a mini-expert system (wizard) that contains all the
components used in setting up GNOME. Each Location File contains generalized
information about the tides, currents, and shorelines in the region it covers. In addition,
the Location File contains error checking and extensive user Help topics, designed to
guide you through running the model. GNOME uses the Location File information, along
with other information you provide, to set up the trajectory model.

Once you have chosen a Location File, GNOME will prompt you for several pieces of
information that it needs to run the model, such as wind conditions, circulation patterns,

river flow rate, and the oil spill(s) you wish to simulate. GNOME’s Help topics provide
some sources of real-time and historical data about the region to answer these questions.
When you have selected your answers, the mini-expert system converts your answers into
model parameters.

In Standard Mode and GIS Output Mode, you will always be prompted for information
about the start and stop times for the model, and the local wind conditions. Some
locations require other information, such as circulation patterns or river flow data, so
when you are working with those Location Files, GNOME also asks you for that
information. (Try the Columbia River Estuary Location File for an example of river
flow choices. To help you provide this information, GNOME always includes a list of
references and Web sites where you can find the data you need.)

The most common current patterns found in a particular area are loaded in each Location
File. If there is more than one current pattern in your Location File, you will need to
select the one that is most appropriate for the scenario you want to represent. (See the
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Santa Barbara Channel Location File for an example of current pattern choices.)
Time variations of currents that result from tides are calculated based on the model start
time and the run duration that you enter.

For more technical information about GNOME’s Location Files, see the Technical
Documentation section of the User’s Guide for the Location File of interest. User’s
Guides are available at this section of our Web site:
http://response.restoration.noaa.gov/software/gnome/locfiles.html.

A collection of all available Location Files is available at
http://response.restoration.noaa.gov/software/gnome/locfiles.html. NOAA HAZMAT
is initially creating Location Files following a Coast Guard priority list of 32 Marine
Safety Offices. Other Location Files will be created as resources allow. If you have
questions about the Location File list, contact NOAA HAZMAT at
ORR.GNOME@noaa.gov.

The Map Window

When you are ready to set your spill(s) in GNOME, a map of a Location File area is
displayed in the Map Window. The Map Window has two sections. The right side
displays a map of the location you selected (including latitude and longitude bounds) and
the GNOME toolbar. As you move your cursor across the map, GNOME displays in the
lower left section of the window your cursor’s geographical location. (In Diagnostic

Mode, GNOME displays current velocity information in the lower left section.)

The left side of the Map Window, the Summary List, details the information about your
model: your Model Settings, the Location File you have chosen, the Wind conditions you
have specified, and the Spill(s) that you will enter. To see detailed information for each
topic, click the triangle (carat) to the left of the topic.

http://response.restoration.noaa.gov/software/gnome/locfiles.html
http://response.restoration.noaa.gov/software/gnome/locfiles.html
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After you have run the model, you may want to change some of its conditions. You can
change your model conditions by double-clicking the items in the Summary List.

Double-click Model Settings to change your Model Start Date, Start Time, Run
Duration, or to include the Minimum Regret (Uncertainty) solution in your model.
(Some Model Settings changes, such as changes to the Start Time, or adding the
Minimum Regret solution, will cause the spill model to “rewind” to the beginning.)

Double-click Location File to change to a new Location File. (You may want to
save your model results before you open a new file. To do this, click Save under
the File menu, select a file type, then click OK.)

Double-click the name of your Location File to change the wind conditions,
flow rate, or circulation pattern for your region.

Double-click Wind to change the speed or direction of the constant or variable
wind. (If you have chosen a constant wind and want to change it to a variable
wind, double-click Location File. The Location File Welcome window will
appear with all the settings you have chosen. You only have to enter
information that you are changing, so in the Choosing Wind Type window,
choose “variable” from the pull-down menu.)
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Double-click Spills to add a new spill to the model. You can add a point or line
source spill (Point/Line Source Splots) or you can spray a spill on the map to
represent observations made during an overflight of the spill area (Sprayed
Splots).

Double-click the description of your spill to change the spill date and time or
pollutant information. (A point or line source spill is shown as "[pollutant type]:
[amount released]". An overflight spill is shown as "[pollutant type]:
overflight".)

In the Spills item of the Summary List, GNOME calculates a mass balance of the “best
guess,” or forecast, solution for each spill. The mass balance is the fate of different
portions of the spill due to the trajectory, the pollutant type, and the weathering that the
pollutant has undergone. GNOME shows the proportion of your spill that is released,

floating, beached, evaporated and dispersed, and off the map. If you model more than one
spill, you will also see a summary mass balance, Splot Mass Balance Totals, listed first
(in the units of the first spill).

GNOME Tools

GNOME’s tools help you set your spill(s) and view your trajectory in the Map Window.

The Arrow Tool. Use this tool to de-select other GNOME tools (such as the
Spray Can tool) and to navigate through the Summary List.

The “Zoom-In” Tool. The scale and coverage of the GNOME maps are fixed;
however, with this tool selected, you can zoom in to see a particular region more
closely. When you click this tool, your cursor changes to a “plus” magnifying
glass ( ). Click on the map to “zoom in.” The map will be re-centered on the
point you clicked. You can also click this tool, then drag on the map to draw a
square. The square will be zoomed to fit the window.
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The “Zoom-Out” Tool. With this tool selected, you can “zoom out” on the map.
When you click this tool, your cursor changes to a “minus” magnifying glass
( ). Click on the map to “zoom out.” The map will be re-centered on the point

you clicked. You can also double-click this tool to fit the map to the window.

The Hand Tool. With this tool selected, you can move the map within the
window. When you click this tool, your cursor changes to a “hand” ( ). Click
and drag to move the map around within the window.

The Spill Tool. With this tool selected, you show the location of your spill(s).
When you click this tool, your cursor changes to a cross hair ( ). Click on the
water area of the map to indicate the location of a point source, or click and drag
on the water area to indicate the location of a line source. (Note that the latitude
and longitude of your cursor will be shown in the lower left corner as you move
it across the map.)

The Spray Can Tool. With this tool selected, you can "spray" a spill on the map

to represent the observations made during an overflight of the spill area. When
you click this tool, you first need to enter information about the overflight and
pollutant, then you choose the diameter of spray you want to use on the map.

Your cursor then changes to a small, medium, or large circle , , .  To spray
the spill, click an appropriate water region of the map, then drag the cursor to
spray blue pollutant particles. (When you run the model, these splots will not be

visible until the model time reaches the overflight time.) If you want to change
the diameter of your spray, double-click the Spray Can tool, then select a new
size.

The Eraser Tool. With this tool selected, you can remove spill particles that you

have sprayed in error. When you click this tool, your cursor changes to a square
( ). Drag the cursor over the area of pollutant to be removed, then release your
mouse button. (Any land areas or lines of latitude or longitude that you "erase"
from the map will be immediately redrawn.)
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The Map Window also includes controls in the Movie Progress Bar that help you run
your trajectory, or spill movie.

Movie Progress Bar

Run. To start the model, click the Run control. The model will run for the

duration period that you chose. (This control changes into the Pause control

whenever the model is running.)

Pause. To pause the model while it is running, click the Pause control, which

appears only while the model is running. To resume running, click Run.

Step. To start and stop the model one step at a time, click Pause, then click Step.

The model will advance the oil spill in small, pre-set time increments.

Reset. To “rewind” the model, click Reset.

If you want to run your trajectory until a particular time, drag the time marker, , below
the Movie Progress Bar, to the time when you’d like the model to stop. You can also use
this control to view earlier pictures of your trajectory. To do this, just drag the time
marker forwards or backwards (in 1-hour increments) to the time you would like to view.

GNOME Menus

GNOME’s menu bar contains five menus: File, Edit, Item, Model, and Help. Here are
explanations of how you can use these menus in GNOME.

The File Menu

GNOME’s File menu works in much the same way as other applications.
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The File menu on a Macintosh (left) and in Windows (right)

Open…

Click Open… to open a Location File or other file type. The following window will
display, showing the Location Files you have downloaded and any files you have saved.

The Open a File window on a Macintosh (left) and in Windows (right)

You can also choose Open… to work with model information you have previously saved
as a Location File Save (.LFS). See the Save… topic later in this section for more
information about saving files in GNOME.

Close

Click Close to close the Location File you are working with. (If you wish to save a
trajectory you have created, be sure to save your trajectory as a Location File Save or
QuickTime Movie before you close the Location File.)
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Save…

Click Save… from GNOME’s File menu when you wish to save the results of your work
in a file.

The Save window in GNOME

You can save in several formats, depending on the model mode you are working in.

In Standard Mode, you can save a file in either of two formats:

∑ Location File Save (.LFS)
∑ QuickTime Movie

In GIS Output Mode, you can save a file in these formats:

∑ Location File Save (.LFS)
∑ QuickTime Movie
∑ NOAA Standard Splot Files (for GIS)
∑ NOAA Standard Splot File Series (for GIS)
∑ GNOME Splot File (for GNOME Analyst)
∑ GNOME Splot File Series (for GNOME Analyst)
∑ BNA Map File (for GNOME Analyst)
∑ Wind Data File

In Diagnostic Mode, you can save a file in these formats:

∑ Diagnostic File Save (.SAV)
∑ QuickTime Movie
∑ NOAA Standard Splot Files (for GIS)
∑ NOAA Standard Splot File Series (for GIS)
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∑ GNOME Splot File (for GNOME Analyst)
∑ GNOME Splot File Series (for GNOME Analyst)
∑ BNA Map File (for GNOME Analyst)
∑ Wind Data File

A Location File Save is a file format that saves all the information you have entered into
GNOME using a Location File. In Standard and GIS Output Modes, GNOME must have
access to the Location File in order to properly open and run your Location File Save.

A QuickTime Movie is a “movie” animation of a modeled spill, produced hourly, that
will run as a stand-alone file. To view QuickTime‘ files, you will need the free

QuickTime player available for download at
http://www.apple.com/quicktime/download/.

NOAA Standard Splot File output is useful for Geographical Information Systems
(GIS) users. The NOAA Standard Splot Files format produces a single view of the spill,
whereas the NOAA Standard Splot File Series produces hourly files throughout the
animation of the spill model. Part of these file outputs is a geo-referenced point file in
MOSS (Map Overlay Statistical System) file format. MOSS is an ASCII, public domain
format that can be imported by many GIS systems. Using a GIS, you can integrate this
output with other geo-referenced data. You can then view diverse data sets together, or

generate spatial queries to determine potential areas of impact and resources at risk.
NOAA HAZMAT has created an extension for use with ArcView, one popular GIS
package. This extension allows easy access to the Standard Splot Files and allows the
import of spill contours generated by GNOME Analyst.

GNOME Splot Files are an output format that can be processed further in the NOAA
application, GNOME Analyst (formerly known as TAT). GNOME Analyst converts the
"best guess" splots displayed in GNOME to oil concentration contours, and the
"minimum regret" splots to a bounding contour. The GNOME Splot Files format outputs
a single time snapshot of the spill model; whereas the GNOME Splot File Series format
produces hourly files throughout the animation of the spill model.

The file output BNA Map File is useful for GNOME Analyst users. To create oil
concentration contours in GNOME Analyst, you need a map file on which to display the
contours. You can open your own vector map in GNOME Analyst, or you can save the
map from the GNOME Location File, and open it in GNOME Analyst.

http://www.apple.com/quicktime/download/
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The file format Wind Data File is useful for those who use NOAA HAZMAT's oil
weathering program, ADIOS. If you create a time-dependent wind in GNOME, you can
save that wind as a text file and read it into ADIOS without having to re-enter the winds.

For more information about NOAA Standard Splot Files, GNOME Splot Files, BNA

Map Files, and Wind Data Files, see the Working With GIS chapter (chapter 3) of this
manual.

A Diagnostic File Save (.SAV) is an output file format that saves all model settings and
files used to produce a trajectory in Diagnostic Mode. It is not available in Standard or
GIS Output Modes.

Page Setup… or Print Setup…

Click Page Setup… on a Macintosh, or Print Setup… in Windows, to adjust the
standard printing options, such as the printer to be used, the size and orientation of the
paper, and the scale you wish to use when you print your results.

The Page Setup (Macintosh) and Print Setup (Windows) dialog boxes
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Because the map prints at a constant aspect ratio, the scale that you choose affects the
size of the text that is printed. For example, a page setup that includes a scale of 60% will
produce smaller text and a larger map.

Print…

You can print a GNOME trajectory in a form similar to this.

This trajectory was created using climatological currents from a GNOME Location File, 
and is unlikely to represent conditions existing at any particular time at the depicted 
location. Use Location Files only to create spill scenarios for training or educational 
purposes, not for actual spill response.

Model Mode:  Standard
Estimate for:  13:15 12/23/98
Prepared:  16:21 12/07/98

Scenario Name:  Drill 6
Prepared by:  GNOME User
Contact Phone:  (800) 555-0123

Columbia River Estuary
River Flow:  500 kcfs
Wind:  Variable 5 knots from NNE
Number of Spills:  1

Black Splots: Best Guess,  Red Splots: Uncertainty
Mass Balance Totals (Best guess):

Released:  xxx barrels 
Evaporated:  xxx barrels
Beached:  xxx barrels
Off Map:  xxx barrels
Floating:  xxx barrels

Your printout will include the spill trajectory that you are displaying in the Map Window.
The top section of your printout includes this information:

∑ the model mode used to create the trajectory.
∑ the time and date of the trajectory “picture.”
∑ the time and date the trajectory was printed.
∑ your scenario name.
∑ your name and contact phone number.
∑ an optional caveat.
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In the bottom section of the printout, the following information is provided:

∑ the Location File used (if applicable).
∑ river flow, current pattern, or other settings unique to the Location File.
∑ wind type (variable or constant), speed, and direction at the time the trajectory

“picture” was taken.
∑ the number of spills.
∑ legend information (Black Splots: Best Guess; Red Splots: Uncertainty).
∑ mass balance totals of all “Best Guess” solutions.

To print your spill trajectory, click Print in the File menu. The following window will
display.

In the Output Header window, you view or add the information that will appear on the
printed copy of your trajectory.

1. Under Print Mode, choose to print your trajectory in either “black & white” or
“color”. (The “black & white” print option creates a faxable copy.)

2. In the next section, Estimate for:, GNOME shows the time and date when your
trajectory “picture” was taken (i.e., the end of your run duration, or the time and date
when you stopped the model).

3. The section Prepared: shows the current time and date (taken from your computer’s
internal clock).

4. In the section, Scenario Name:, type a name to identify your trajectory.
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5. Enter your name in the section, Prepared by:.

6. Enter an appropriate phone number in the section, Contact Phone:.

7. If your trajectory was created with a GNOME Location File, this standard caveat will
be displayed on your printed copy:

“This trajectory was created using climatological currents from a GNOME Location
File and is unlikely to represent conditions existing at any particular time at the
depicted location. Use Location Files only to create spill scenarios for training and
educational purposes, not for actual spill response.”

To change this text, click the Edit Caveat… button, then type the text you want to
include.

8. Click OK.

A standard Print dialog box will open, where you can specify the printer and number

of copies you want to print.

Preferences…

Click the Preferences… item in the File menu to (1) change the appearance of the grid in
the Map Window, or (2) change the model mode of GNOME.

To change the grid settings, click the Grid tab,  .
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Click the show lat/long grid box to show the latitude and longitude lines in the Map
Window. (Click the box again to hide the latitude and longitude lines.)

Next, you can change the units in which you’ll see and enter position data in GNOME.
Choose one of the radio buttons to select “degrees”, “degrees/minutes”, or

“degrees/minutes/seconds”. In the lower left corner of the Map Window, GNOME will
show the position of your cursor in the format you’ve chosen.

To show the grid on top of the map, click “top” in the position: section. If you prefer to
view the grid beneath the map, click “bottom”.

Click the show intermediate lines box if you’d like the lines of longitude and latitude
shown in smaller increments. If you want the lines shown in specific increments, click the
custom grid box, then enter the increments in which you want the lines shown and
labeled.

To change the GNOME Model Mode, click the Mode tab, .

Under Model Mode, choose the mode in which you’d like to work: Standard, GIS
Output, or Diagnostic.

If you work predominantly in one mode of GNOME, you can instruct GNOME to open
in that mode each time it starts up. Under Startup Model Mode, choose Standard, GIS
Output, or Diagnostic.
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Note: When you change from Standard Mode to GIS Output Mode while
you’re working on a trajectory scenario, the information you’ve entered will
be saved, but the model will reset to its Start Time.

If you change from GIS Output Mode to Standard Mode, GNOME will

again retain your settings; however, you will only be able to output your
trajectory in the output formats of Standard Mode.

If you change to Diagnostic Mode, GNOME will alert you that you are changing
to a mode that requires detailed knowledge of trajectory modeling, and will
suggest that you first save your Location File settings. You won’t be able to
change from Diagnostic Mode to another mode without losing all your model
information.

Quit or Exit

In the File menu, click Quit on a Macintosh or Exit in Windows to close GNOME. (If
you want to save a trajectory you have created, be sure to save it as a Location File Save
or QuickTime Movie before you close GNOME.)

The Edit Menu

You’ll probably recognize the items in the Edit menu in GNOME. They work the same
way as in other computer applications; however, the Undo menu item is not currently
implemented in GNOME. The Macintosh version of GNOME includes three items in the
Edit menu: Cut, Copy, and Paste, and their keyboard shortcuts. The Windows Edit menu
includes only the Copy item; however, the standard Windows shortcuts for Cut (Ctrl+X)
and Paste (Ctrl+V) work the same way in GNOME as in other computer applications.

The Edit menu on a Macintosh (left) and in Windows (right)
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Cut

Click Cut in the Edit menu to delete any selected text you’ve entered in a GNOME
dialog box.

Copy

In the Map Window, click Copy to copy your model result to the clipboard. You can then
paste your copied item into a word processing or graphics application. In a dialog box,
you can click Copy to copy any selected text. You can then paste the text in a text box of
another dialog box.

Paste

Select a text box in a dialog box, then click Paste to add data you have cut or copied.

The Item Menu

The Item menu contains four items in Standard and GIS Output modes. (The Move Up
and Move Down menu items are used only in GNOME’s Diagnostic Mode.) Some of the
Item menu items are available only when appropriate items in the Summary List are
highlighted. For example, the Add... item is available only when you have highlighted
Spills in the Summary List.

The Item menu on a Macintosh (left) and in Windows (right)

Location Wizard…

Click Location Wizard… in the Item menu to change any of the information you entered

in GNOME. A series of windows will open, beginning with the Location File Welcome
window, to allow you to adjust your model settings and other conditions.
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You will soon learn a quicker way to make these changes: double-click an item listed in
the Summary List of the Map Window to open the dialog box applicable to that item.

Add…

To add a new spill to your scenario, highlight Spills in the Summary List, then click
Add… in the Item menu. (Double-clicking the Spills item will produce the same result.)
The following window will display.

You can simulate three types of spills in GNOME:

1.  Use point source splots to represent either an instantaneous spill (catastrophic release)
or an oil release that occurs over time at a particular location (e.g., a stationary vessel or
pipeline leak).

2.  Use line source splots to simulate a spill from a vessel that is leaking as it is drifting,
or an observation of a linear slick from an unknown source.

3.  Use sprayed splots to simulate the observations reported from an overflight of the spill
area.
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To set a point or line source, select Point/Line Source Splots, then click Create. On the
next window, you will provide more information about the spill, including:

∑ Pollutant type
∑ Amount released

∑ Release start and stop dates and times

To "spray" overflight splots on the map, select Sprayed Splots, then click Create. On the
next two windows, you need to provide more information, including:

∑ Overflight date and time
∑ Pollutant type
∑ Amount released
∑ Time that the amount was estimated (if the pollutant is a type that weathers)
∑ Pollutant age (if the amount was estimated during the overflight)
∑ Time of spill (if the amount was estimated at the time the spill occurred)

∑ Diameter of "spray" you want to use on the map

Settings…

Click Settings… to change any of the information you entered in the Model Settings
window, shown below.

You can also double-click the Model Settings item in the Summary List of the Map
Window to change the settings you have entered.
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Delete

To delete a spill from your scenario, first highlight the name of the spill in the Summary
List. A point or line source spill is shown as "[pollutant type] : [amount released]" in the
Summary List. An overflight spill (sprayed splots) is shown as "[pollutant type] :
overflight". To delete the spill, click Delete in the Item menu. GNOME will prompt you
to confirm that you want to delete the selected spill. Click OK.

The Model Menu

The Model menu items operate in a similar way to GNOME’s run controls:

The Model menu on a Macintosh (left) and in Windows (right)

Run

Click Run in the Model menu to see your spill trajectory. (You can also run your

trajectory by pressing the Run control, , on the GNOME toolbar.)

Step

Click Step to run your trajectory in small, pre-set time increments. (Another way to run

your trajectory incrementally is to use the Step control, , on the toolbar.)

Run until…

If you want to stop your trajectory at a particular time during its Run Duration, you can
set GNOME to run until that time. Click Run Until… in the Model menu, then enter
your stop date and time in the Run Until dialog box, shown below.
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(You can also use the toolbar to run your trajectory until a particular time. Drag the time
marker, , below the movie progress bar to the time when you’d like the model to stop.)

Reset

Click Reset in the Model menu to rewind your spill movie. (You can also rewind the

movie by clicking the Reset control, , on the GNOME toolbar.)

The Help Menu

From the Help menu, you can view explanations of GNOME’s main functions and
features. The GNOME Help menu differs between the Macintosh and Windows operating
systems.

On a Macintosh

The Help menu on a Macintosh
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About Balloon Help…

Click About Balloon Help… to learn more about the Macintosh Balloon Help.

Show Balloons

Click Show Balloons to turn Balloon Help on.

Hide Balloons (appears only when Balloon Help is turned on)

Click Hide Balloons to turn Balloon Help off.

Topics…

Click Topics… from the Help menu to see the list of GNOME Help Topics. Select the
topic you’d like to see, then click Select.

Sample GNOME Help topic on a Macintosh

When you’ve finished reading the topic discussion…

∑ click Topics to return to the Help index to select another topic.
∑ click Done to return to GNOME.
∑ click Copy to copy the discussion text to the clipboard.
∑ click Print to print the Help topic.
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In Windows

The Help menu in Windows

Contents

In Windows, select Contents from the Help menu to view the GNOME Help contents.

Click any of the underlined topics in GNOME Help (background) to view
the discussion of that topic (foreground).

When you’ve finished reading the topic discussion…

∑ click Contents to return to the GNOME Help Contents.
∑ click Search to go to the GNOME Help Index.
∑ click Back to view the previous Help topic.
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∑ click Print to print the Help topic.

∑ click the Close button,  , in the upper right corner of the window to return to
GNOME.

Search for Help On…

Click Search for Help On… to display an alphabetical index of GNOME Help topics in
Windows. You can type the first few letters of the word you’re looking for, or you can
highlight a topic from the list, then click Display, to view the discussion of that topic.

The GNOME Help Index in Windows

How to Use Help

Click How to Use Help to learn more about Windows Help. Windows provides three
sections of help: a Contents, an alphabetical Index, and a Find capability.
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About GNOME…

Click About GNOME… to see the version of GNOME in which you are working.

The GNOME Splash Screen
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Chapter 5

Troubleshooting

Often, when you encounter difficulties while running GNOME, it will alert you to the
problem. At other times, you may encounter a problem and be unsure of how to solve it.
Here are some cases you might encounter:

I don’t see a Location File for an
area I’d like to model.

We are currently preparing Location Files to
support the work of the U.S. Coast Guard's
Marine Safety Offices. To see what locations
are currently available, check our Web site at
http://response.restoration.noaa.gov/softwa
re/gnome/locfiles.html . To learn what
Location Files will be available soon, check

this section of our site:  http://response.restor
ation.noaa.gov/software/gnome/news.html .
If you have questions about the list of Location
Files, contact NOAA HAZMAT at
ORR.GNOME@noaa.gov.

I’m a GIS user, and I don’t see the
GIS-compatible file formats when I
try to save a file. What’s wrong?

You’ve opened GNOME in Standard Mode
instead of GIS Output Mode. To change to
GIS Output Mode, from the File menu, choose
Preferences, click the Mode tab, then click
GIS Output.

I am using a CD version of GNOME.
When I try to quit GNOME, I get
this message: “Error saving
settings.”

When you run GNOME from a CD, GNOME
cannot write the settings file (settings.osm) to
the CD when you exit the application, so it
displays the error message. To solve this
problem, copy GNOME and the Location Files
to a directory on your hard drive and run
GNOME from there.

Other troubleshooting issues are discussed in the FAQ section of our Web site at
http://response.restoration.noaa.gov/software/gnome/gnomefaq.html.

http://response.restoration.noaa.gov/software/gnome/locfiles.html
http://response.restoration.noaa.gov/software/gnome/news.html
http://response.restoration.noaa.gov/software/gnome/gnomefaq.html
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Appendix

Example NOAA Standard Splot File Output

Following are examples of the file formats for GNOME's NOAA Standard Splot File
output. These files are the same as files three through seven of the Standard NOAA
Trajectory Output.

.ms3 File

The .ms3 file contains caveat and spill-specific information.

.ms4 File

The .ms4 file is a MOSS point file with the position data of the forecast splots.
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.ms5 File

The .ms5 file links by the index field to the forecast MOSS file. It provides information

applicable to individual splots, such as oil type, age of the splot, and whether it is
beached or floating.

.ms6 File

The .ms6 file provides the position data for the “minimum regret” (uncertainty) splots (if

they are included in the trajectory).
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.ms7 File

The .ms7 file provides attributes of each of the “minimum regret” splots (if they were

included in the trajectory).

For more information on the Standard NOAA Trajectory Output, see HAZMAT Report
96-4, Digital Distribution Standard for NOAA Trajectory Analysis Information, J.A.
Galt, D.L. Payton, H. Norris, and C. Friel, January 1996.
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Glossary

24-hour time The system of expressing time in which the time
of day is indicated by four digits. The first two
digits indicate the hour (00 to 23) and the last two
indicate the number of minutes past that hour (00
to 59). Each day begins at midnight, 0000, and the
last minute of each day is 2359. Under this
system, 6:00 a.m. is 0600, and 2:30 p.m. is 1430.

Best guess trajectory A trajectory that assumes that all of the
information that is input into the model (winds,
currents, tides, etc.) is exactly correct. Also known
as the forecast trajectory, this trajectory represents
our best guess of where spilled oil will go.

BNA Map File (for GNOME
Analyst)

An output file that saves the map from a GNOME
Location File for use in the NOAA HAZMAT
program, GNOME Analyst. Available only in GIS
Output and Diagnostic modes.

Constant wind Wind that is blowing steadily at a particular speed
from a particular direction.

Diagnostic File Save (.SAV) An output file format that saves all model settings
and files used to produce a trajectory in Diagnostic
Mode. Available only in Diagnostic Mode.

Diagnostic Mode The most advanced mode of GNOME. In
Diagnostic Mode, you can use a Location File to
load information into GNOME, or you can set up
the model entirely on your own. Diagnostic Mode

was designed for use by experts during tactical
support for spill response teams. Use of this mode
requires training from NOAA HAZMAT.
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Dialog box A window that GNOME presents to you, in which
you enter information or choose options.

Forecast trajectory A trajectory that assumes that all of the

information that is input into the model (winds,
currents, tides, etc.) is exactly correct. Also known
as the “best guess” trajectory because it represents
our best guess of where the spilled oil will go.

GIS Geographic Information System. A computer-
based tool for mapping and analyzing things that
exist and events that happen on earth. GIS
technology integrates common database
operations, such as query and statistical analysis,
with the unique visualization and geographic

analysis benefits offered by maps.

GIS Output Mode A GNOME mode in which you can export model
output in GIS- (geographic information system)
compatible format. GIS Output Mode is primarily
used for spatial or GIS analysis. Use of this mode
requires training from NOAA HAZMAT.

GNOME The General NOAA Oil Modeling Environment.
The oil spill trajectory model described in this
manual.

GNOME Analyst A NOAA application, formerly known as TAT,
that converts “best guess” splot number and
position data into oil density contours, and
converts “minimum regret” splot location data into
an uncertainty bounding contour.

GNOME Splot File (for
GNOME Analyst)

An output file format available in GIS Output and
Diagnostic modes that provides a single time
snapshot of the spill model for GNOME Analyst.
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GNOME Splot File Series
(for GNOME Analyst)

An output file format available in GIS Output and
Diagnostic modes that produces hourly files
throughout the animation of the spill model for
GNOME Analyst.

HAZMAT Hazardous Materials Response Division of NOAA
Office of Response and Restoration (OR&R).

Hindcast In spill modeling, a model run for some time in
the future is called a forecast. When you know the
actual spill situation and want to create model
conditions to represent that situation for a time in
the past, you are creating a hindcast. Modelers use
hindcasts to test how changes to the model
conditions affect the results. HAZMAT modelers

use hindcasts to test their simulation of the most
recent events, with the goal of making their next
forecast more accurate.

Line source In GNOME, a line source simulates a spill from a
vessel that is leaking as it is drifting, or an
observation of a slick from an unknown source.

Location File Files containing generalized information about the
tides, currents, and shorelines of a given region.
GNOME uses this information and the

information that you provide to set up the
trajectory model.

Location File Save (.LFS) An output file format that saves all the information
you have entered into GNOME using a Location
File. In Standard and GIS Output modes, GNOME
must have access to the Location File in order to
properly open and run the Location File Save.

Mass balance The fate of different portions of a spill due to the
trajectory, the pollutant type, and the weathering

that the pollutant has undergone.
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Minimum regret trajectory A trajectory that incorporates uncertainties in the
model. It shows areas of the map that could be
impacted if, for example, the wind blows from a
somewhat different direction than you have

specified, or if the currents in the area flow
somewhat faster or slower than expected. It
represents other possibilities of where the spill
might go.

Model modes Levels in which GNOME can be run. GNOME
was designed with three model modes: Standard
Mode, GIS Output Mode, and Diagnostic Mode.
Standard and GIS Output Modes must use
Location Files to run. Diagnostic Mode can use
Location Files or user files. GIS Output Mode and

Diagnostic Mode require training from NOAA
HAZMAT.

Model settings Details about your model, or “spill movie.” You
need to enter a Start Date and Start Time when
you would like your spill movie to begin, and a
Run Duration for the movie. You can also indicate
whether you would like the model to compensate
for uncertainty in the input data.

MOSS Map Overlay Statistical System, a public domain

GIS format.

NOAA National Oceanic and Atmospheric
Administration. An organization of the
Department of Commerce, NOAA is composed of
the National Ocean Service (NOS); National
Weather Service; National Marine Fisheries
Service; National Environmental Satellite, Data,
and Information Service; and Office of Oceanic
and Atmospheric Research. HAZMAT is a portion
of the Office of Response and Restoration under

NOS.
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NOAA Standard Splot Files
(for GIS)

An output file format available in GIS Output and
Diagnostic modes that produces a single view of
the spill that can be viewed in ArcView, using the
ArcView extension.

NOAA Standard Splot File
Series (for GIS)

An output file format available in GIS Output and
Diagnostic modes that produces hourly files
throughout the animation of the spill model. These
files can be viewed in ArcView, using the
ArcView extension.

"No-Notice" Drill A response drill in which no advance notice is
given to the responding parties (government,
industry, and/or contractors) to exercise and test
spill preparations and readiness.

Non-weathering pollutant A pollutant type that does not change chemically
or physically over time in the marine environment.

OR&R Office of Response and Restoration. Includes the
Hazardous Materials Response Division
(HAZMAT), the Coastal Resource Protection and
Restoration Division, and the Damage Assessment
Center.

Overflight An airplane or helicopter flight over a spill area to

determine the location and extent of the spill.
Overflights are critical for making good forecasts.

Point/Line Source Splots A type of spill that can be modeled in GNOME to
represent a point or line source. See Point source
and Line source.

Point source In GNOME, a point source represents either an
instantaneous spill (catastrophic release) or an oil
release that occurs over time at a particular
location (e.g., a stationary vessel or pipeline leak).
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Pollutant age The number of hours the pollutant has been in the
water. When you are using GNOME's overflight
tools, the pollutant age is the time of the overflight
minus the time of the spill.

Pollutant types The oil and oil products for which GNOME can
calculate weathering information.

QuickTime Movie (.mov) A “movie” animation of a modeled spill, produced
hourly. Will run as a stand-alone file that can be
viewed with the QuickTime player.

Reinitialize To reset or restart GNOME with different initial
conditions.

Reinitialized trajectory A trajectory that incorporates the observations

made during an overflight of the spill area. Spill
particles are sprayed on the map to represent the
last observed location and extent of the spill.

Run duration The amount of time that you would like the model,
or “spill movie,” to run. The minimum time for a
run duration is 1 hour; the maximum time is 3 days.

Scenario A description of where, how, how much, and what
type of oil has spilled, and the current
environmental conditions.

Splots Tiny, representative pieces of spilled oil in a
GNOME spill trajectory. They appear as small
“pollutant particles” on the map when you run
your spill; however, different types of splots are
represented in different ways. In any trajectory
that includes a "minimum regret" solution, black
splots represent GNOME’s best guess of where
spilled oil will go. (For all black splots, wind and
model data are assumed to be correct.) Red splots
represent the "minimum regret" area for the same

spill. When splots beach, they change to tiny “x”s
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Splots (continued) on land regions of the map. Beached “best guess”
splots are shown as black "x"s; beached
“minimum regret” splots are shown as red "x"s. In
a trajectory that has been sprayed with GNOME's
Spray Can tool, blue splots represent the area

where oil has been observed in an overflight of the
spill.

Sprayed Splots A type of spill that can be modeled in GNOME to
represent the observations made during an
overflight of the spill area. Tiny pollutant particles
(splots) are added to the spill scenario with the
GNOME Spray Can tool. These particles appear
blue on the map until the trajectory is run.

SSC Scientific Support Coordinator.

Standard Mode The most automated mode of GNOME. In
Standard Mode, a Location File loads information
into GNOME, then GNOME prompts you for
information it needs to run your model. In this
mode, you can print a picture or create a "movie"
of your trajectory. Standard Mode is not flexible
enough to be used for spill response; however, it is
an excellent tool for simulating spills and building
intuition regarding oil spill trajectories at specific
locations.

TAT A NOAA application, now known as GNOME
Analyst, that converts “best guess” splot number
and position data into oil density contours, and
converts “minimum regret” splot location data into
an uncertainty bounding contour.

Trajectory The direction and pattern of movement of spilled
oil over time.
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Uncertainty Our knowledge that observations and forecasts are
not perfect. GNOME always produces a "best
guess” trajectory, but will also include the
possibility of inaccuracies in a "minimum regret"

trajectory if you request it in your Model Settings.

Uncertainty trajectory A trajectory that incorporates uncertainties in the
model. It shows areas of the map that could be
impacted if, for example, the wind blows from a
somewhat different direction than you have
specified, or if the currents in the area flow
somewhat faster or slower than expected. It
represents other possibilities of where the spill
might go.

Weathering Physical and chemical changes that a pollutant
undergoes while it is exposed to the environment.
In the marine environment, a pollutant can change
in its density, viscosity (resistance to flow), rate of
evaporation and dispersion into the water column,
and the rate at which an oil-in-water mixture may
form. The weathering behaviors of different
pollutants are critical to predicting their
trajectories. GNOME uses a simple weathering
model; NOAA HAZMAT's oil weathering
program, ADIOS, provides more detailed

estimates of the expected characteristics and
behavior of oil spilled into the marine
environment.

Unified Command Representatives of the party responsible for an oil
spill, and the State and Federal governments who
are in charge of the spill response.

Variable wind Wind that is changing speed and direction
frequently.
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Wind Data File An output file format available in GIS Output and
Diagnostic modes that saves wind records as a text
file for use in NOAA HAZMAT's oil weathering
program, ADIOS.

Wind direction The direction from which the wind is blowing.
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